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Control System Toolbox & SIMULINK 

�ng d�ng �� phân tích, thi�t k� và mô ph�ng các h� th�ng tuy�n tính 
Tr�n �ình Khôi Qu�c, BM. T� ��ng hóa. Email : tdkquoc@dng.vnn.vn 

 
GI�I THI�U 
 MATLAB, tên vi	t t
t c�a t� ti	ng Anh MATrix LABoratory, là m�t môi tr�ng m�nh 
dành cho các tính toán khoa hoc. Nó tích h�p các phép tính ma tr�n và phân tích s� d�a trên các 
hàm c� b�n. H�n n�a, c�u trúc �� h�a h�ng ��i t�ng c�a Matlab cho phép t�o ra các hình v� 
ch�t l�ng cao. Ngày nay, Matlab tr� thành m�t ngôn ng� « chu�n » ��c s� d�ng r�ng rãi trong 
nhi�u ngành và nhi�u qu�c gia trên th	 gi�i. 
 V� m�t c�u trúc, Matlab g�m m�t c�a s  chính và r�t nhi�u hàm vi	t s!n khác nhau. Các 
hàm trên cùng l"nh v�c #ng d�ng ��c x	p chung vào m�t th vi$n, �i�u này giúp ng�i s� d�ng 
d% d�ng tìm ��c hàm c�n quan tâm. Có th& k& ra m�t s� th vi$n trong Matlab nh sau : 

- Control System (dành cho �i�u khi&n t� ��ng) 
- Finacial Toolbox (l"nh v�c kinh t	) 
- Fuzzy Logic (�i�u khi&n m�) 
- Signal Processing (x� lý tín hi$u) 
- Statistics (toán h�c và th�ng kê) 
- Symbolic (tính toán theo bi&u th#c) 
- System Identification (nh�n d�ng) 
- … 
M�t tính ch�t r�t m�nh c�a Matlab là nó có th& liên k	t v�i các ngôn ng� khác. Matlab có th& 

g�i các hàm vi	t b'ng ngôn ng� Fortran, C hay C++, và ng�c l�i các hàm vi	t trong Matlab có 
th& ��c g�i t� các ngôn ng� này… 

Các b�n có th& xem ph�n Help trong Matlab �& tham kh�o cách s� d�ng và ví d� c�a t�ng 
l$nh, ho�c download (mi%n phí) các file help d�ng *.pdf t�i trang Web c�a Matlab � �(a ch) 
http://www.mathworks.com 

1 Control System Toolbox 
Control System Toolbox là m�t th vi$n c�a Matlab dùng trong l"nh v�c �i�u khi&n t� ��ng. 

Cùng v�i các l$nh c�a Matlab, t�p l$nh c�a Control System Toolbox s� giúp ta thi	t k	, phân tích 
và �ánh giá các ch) tiêu ch�t l�ng c�a m�t h$ th�ng tuy	n tính. 

1.1 ��nh ngh�a m�t h� th�ng tuy�n tính 

1.1.1 ��nh ngh�a b�ng hàm truy�n 
H� th�ng m�t tín hi�u vào/ra 
 
Câu l$nh: sys=tf(num,den,T) 
 

- num: vect� ch#a các h$ s� c�a �a th#c � t� s�, b�c t� cao �	n th�p theo toán t� Laplace 
(h$ liên t�c) ho�c theo toán t� z (h$ gián �o�n) 

- den: vect� ch#a các h$ s� c�a �a th#c � m*u s�, b�c t� cao �	n th�p 
- T: chu k+ l�y m*u, ch) dùng cho h$ gián �o�n (tính b'ng s) 

 
Ví d�:  
�(nh ngh"a m�t hàm truy�n trong Matlab 
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zF    num=2.1*[1 -0.6];den=[1 -0.56]; 

T=0.5;sys2=tf(num,den,T) 
 
H� th�ng nhi�u tín hi�u vào/ra 
 
 
 

 
 
 
 
 
Câu l$nh :  

G11=tf(num11,den11,T); G12=tf(num12,den12,T);...; G1n=tf(num1n,den1n,T); 
G21=tf(num21,den21,T); G22=tf(num22,den22,T);...; G2n=tf(num2n,den2n,T); 

 
Gp1=tf(nump1,denp1,T); G12=tf(nump2,denp2,T);...; Gpn=tf(numpn,denpn,T); 
sys=[G11,G12,...,G1n;G21;G22;...;G2n;...;Gp1,Gp2,...,Gpn]; 

1.1.2 ��nh ngh�a b�ng zero và c�c 
H� th�ng m�t tín hi�u vào/ra 
 
Câu l$nh:  sys=zpk(Z,P,K,T) 
 

- Z,P là các vect� hàng ch#a danh sách các �i&m zerô và c�c c�a h$ th�ng. 
- K là h$ s� khu	ch ��i 

Chú ý: n	u h$ th�ng không có �i&m zerô (c�c) thì ta ��t là [] 
 
Ví d�: 
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pF   Z=-2;P=[0 -5];K=1;sys=zpk(Z,P,K); 

 
H� th�ng nhi�u tín hi�u vào/ra 
Câu l$nh :  

G11=zpk(Z11,P11,T); G12=zpk(Z12,P12,T);...; G1n=zpk(Z1n,P1n,T); 
G21=zpk(Z21,P21,T); G22=zpk(Z22,P22,T);...; G2n=zpk(Z2n,P2n,T); 
 
Gp1=zpk(Zp1,Pp1,T); G12=zpk(Zp2,Pp2,T);...; Gpn=zpk(Zpn,Ppn,T); 
sys=[G11,G12,...,G1n;G21;G22;...;G2n;...;Gp1,Gp2,...,Gpn]; 

1.1.3 Ph��ng trình tr	ng thái 
 
Câu l$nh:  sys=ss(A,B,C,D,T) 
 

- A,B,C,D là các ma tr�n tr�ng thái �(nh ngh"a h$ th�ng 
- T là chu k+ l�y m*u. 
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1.1.4 Chuy
n ��i gia các d	ng bi
u di�n 
- Chuy&n t� ph�ng trình tr�ng thái sang hàm truy�n 

[num,den] = ss2tf(A,B,C,D) 
- Chuy&n t� d�ng zero/c�c sang hàm truy�n 

[num,den] = zp2tf(Z,P,K) 
- Chuy&n t� hàm truy�n sang ph�ng trình tr�ng thái 

[A,B,C,D]=tf2ss(num,den) 

1.1.5 Chuy
n ��i gia h� liên t�c và gián �o	n 
S� hóa m�t h� th�ng liên t�c 
 
Câu l$nh: sys_dis=c2d(sys,T,method) 
 

- sys, sys_dis h$ th�ng liên t�c và h$ th�ng gián �o�n t�ng #ng 
- Ts th�i gian l�y m*u 
- method ph�ng pháp l�y m*u: ‘zoh’ l�y m*u b�c 0, ‘foh’ l�y m*u b�c 1, ‘tustin’ 

ph�ng pháp Tustin… 

Ví d�: chuy&n m�t khâu liên t�c có hàm truy�n 
15.0

2
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p
pG sang khâu gián �o�n  b'ng 

ph�ng pháp gi� m*u b�c 0, chu k+ l�y m*u T=0.01s 
num=2 
den=[0.5 1] 
sysc=tf(num,den) 
sysd=c2d(sysc,0.01,’zoh’) 
 
H� liên t�c t��ng ���ng c	a m�t h� th�ng gián �o
n 
 
Câu l$nh: sys=d2c(sys_dis,method) 

1.2 Bi�n �	i s
 �� t�
ng ��
ng 

1.2.1 M�c n�i ti�p 
 
 
 
 
 
 
 
Câu l$nh: sys=series(sys1,sys2) 

1.2.2 M�c song song 
Câu l$nh: sys=parallel(sys1,sys2) 

1.2.3 M�c ph�n h�i 
Câu l$nh: sys=feedback(sys1,sys2,sign) 
 
 
 
 
 

sys1 sys2 
U Y 
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sign = +1 n	u ph�n h�i d�ng và sign=-1 (ho�c không có sign) n	u ph�n h�i âm. 

1.3 Phân tích h� th�ng 

1.3.1 Trong mi�n th�i gian 

Hàm quá �� h(t) 
Câu l$nh: step(sys) 
 
V� hàm quá �� c�a h$ th�ng tuy	n tính sys. Kho�ng th�i gian v� và b�c th�i gian do Matlab t� 
ch�n. 
 
M�t s� tr�ng h�p khác 

- step(sys,t_end): v� hàm quá �� t� th�i �i&m t=0 �	n th�i �i&m t_end. 
- step(sys,T): v� hàm quá �� trong kho�ng th�i gian T. T  ��c �(nh ngh"a nh sau 

T=Ti:dt:Tf. ��i v�i h$ liên t�c, dt là b�c v�, ��i v�i h$ gián �o�n, dt=Ts là chu 
k+ l�y m*u. 

- step(sys1,sys2,sys3,…) : v� hàm h(t) cho nhi�u h$ th�ng ��ng th�i. 
- [y,t]=step(sys): tính �áp #ng h(t) và lu vào các bi	n y và t t�ng #ng 

Hàm tr�ng l��ng ωωωω(t) 
Câu l$nh: impulse(sys) 

1.3.2 Trong mi�n t�n s� 

�c tính bode 
Câu l$nh: bode(sys) 
 
V� ��c tính t�n s� Bode c�a h$ th�ng tuy	n tính sys. D�i t�n s� v� do Matlab t� ch�n. 
 
M�t s� tr�ng h�p khác 

- bode(sys,{w_start,w_end}): v� ��c tính bode t� t�n s� w_start �	n t�n s� w_end. 
- bode(sys,w) v� ��c tính bode theo vect� t�n s� w. Vect� t�n s� w ��c �(nh ngh"a 

b'ng hàm logspace. Ví d�: w=logspace(-2,2,100) �(nh ngh"a vect� w g�m 100 �i&m, 
t� t�n s� 10-2 �	n 102. 

- bode(sys1,sys2,sys3,…) v� ��c tính bode c�a nhi�u h$ th�ng ��ng th�i. 
- [mag,phi,w]=bode(sys,…) lu t�t c� các �i&m tính toán c�a ��c tính bode vào vect� 

mag, phi #ng v�i t�n s� w t�ng #ng. 
 
Chú ý: ��i v�i h$ th�ng gián �o�n, d�i t�n s� �& v� ph�i th,a mãn �(nh lý Shannon. 

�c tính Nyquist 
Câu l$nh: nyquist(sys) 

nyquist(sys,{w_start,w_end}) 

sys1 

sys2 

U Y 
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  nyquist(sys,w) 
  nyquist(sys1,sys2,sys3,...,w) 
  [real,ima,w]=nyquist(sys,…) 

�c tính Nichols 
Câu l$nh: nichols(sys) 

nichols(sys,{w_start,w_end}) 
  nichols(sys,w) 
  nichols(sys1, sys2, sys3,...,w) 
  [mag,phi,w]=nichols(sys,…) 
 
Tính toán G(ω), arg[G(ω)] và v� trong m�t ph-ng Black. 
 
Ví d�: V� các ��c tính t�n s� c�a h$ th�ng sau 

 2
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pG   v�i  ω0=1rad/s và ξ=0,5 

w0=1 ;xi=0.5 ;num=w0^2 ;den=[1 2*xi*w0^2 w0^2] ;G=tf(num,den); 
w=logspace(-2,2,100) ; 
bode(G,w) ; % v� ��c tính bode trong d�i t�n s� w 
nichols(G); % v� ��c tính nichols trong d�i t�n s� t� ch�n c�a Matlab 
nyquist(G); % v� ��c tính nyquist 

1.3.3 M�t s� hàm �
 phân tích 

Hàm margin 
- margin(sys) v� ��c tính Bode c�a h$ th�ng SISO và ch) ra �� d� tr� biên ��, �� d� tr� 

pha t�i các t�n s� t�ng #ng. 
- [delta_L,delta_phi,w_L,w_phi]=margin(sys) tính và lu �� d� tr� biên �� vào bi	n 

delta_L t�i t�n s� w_L, lu �� d� tr� v� pha vào bi	n  delta_phi t�i t�n s� w_phi. 

Hàm pole 
vec_pol=pole(sys) tính các �i&m c�c c�a h$ th�ng và lu vào bi	n vec_pol. 

Hàm tzero 
vec_zer=tzero(sys) tính các �i&m zero c�a h$ th�ng và lu vào bi	n vec_zer. 

Hàm pzmap 
- [vec_pol,vec_zer]=pzmap(sys) tính các �i&m c�c và zero c�a h$ th�ng và lu vào các 

bi	n t�ng #ng. 
- pzmap(sys) tính các �i&m c�c, zero và bi&u di%n trên m�t ph-ng ph#c. 

Hàm dcgain 
G0=dcgain(sys) tính h$ s� khu	ch ��i t"nh c�a h$ th�ng và lu vào bi	n G0. 

1.3.4 M�t s� hàm ��c bi�t trong không gian tr	ng thái 

Hàm ctrl 
Câu l$nh: C_com=ctrl(A,B) 
  C_com=ctrl(sys) 
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Tính ma tr�n “�i	u khi�n �
�c”  C c�a m�t h$ th�ng. Ma tr�n C ��c �(nh ngh"a nh sau:  
C=[B AB A2B … An-1B] v�i A∈ℜnxn 

 

Hàm obsv 
Câu l$nh: O_obs=obsv(A,C) 
  O_obs=obsv(sys) 
 
Tính ma tr�n “quan sát �
�c”  O c�a m�t h$ th�ng. Ma tr�n O ��c �(nh ngh"a nh sau:
 O=[C CA CA2 … CAn-1]  
 

Hàm ctrbf 
Câu l$nh: [Ab,Bb,Cb,T,k]=ctrbf(A,B,C) 
 
Chuy&n v� d�ng chu�n (canonique) “�i�u khi&n ��c” c�a m�t h$ th�ng bi&u di%n d�i d�ng 
ph�ng trình tr�ng thái.  
Trong �ó: Ab=TAT-1, Bb=TB, Cb=CT-1, T là ma tr�n chuy&n � i. 
 

Hàm obsvf 
Câu l$nh: [Ab,Bb,Cb,T,k]=obsvf(A,B,C) 
 
Chuy&n v� d�ng chu�n “quan sát ��c“ c�a m�t h$ th�ng bi&u di%n d�i d�ng ph�ng trình 
tr�ng thái.  
Trong �ó: Ab=TAT-1, Bb=TB, Cb=CT-1, T là ma tr�n chuy&n � i. 

1.4 Ví d t	ng h�p 
Cho m�t h$ th�ng kín ph�n h�i -1, trong �ó hàm truy�n c�a h$ h� là 
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pG   v�i  K=1, τ=10s, ω0=1rad/s và ξ=0.5 

1. V� ��c tính t�n s� Nyquist. Ch#ng t, r'ng h$ kín không  n �(nh. 
2. V� �áp #ng quá �� c�a h$ kín. 
3. �& h$ th�ng  n �(nh, ng�i ta hi$u ch)nh h$ s� khu	ch ��i K=0.111. Xác �(nh t�n s� c
t, 

�� d� tr� biên �� và �� d� tr� v� pha c�a h$ th�ng trong tr�ng h�p này. 
4. Xác �(nh các thông s� quá �� (th�i gian quá �� l�n nh�t Tmax, �� quá �i�u ch)nh l�n nh�t 

σmax) c�a h$ th�ng �ã hi$u ch)nh. 
 
TH.C HI�N 
Câu 1 
>>K=1;to=10;w0=1;xi=0.5; 
>>num1=K;den1=[to 1 0]; 
>>num2=w0^2;den2=[1 2*xi*w0  w0^2] ; 
>>G=tf(num1,den1)*tf(num2,den2) 
Transfer function: 
             1 
---------------------------- 
10 s^4 + 11 s^3 + 11 s^2 + s  
>>w=logspace(-3,2,100) ;  % t�o vect� t�n s� �& v� các ��c tính t�n s� 
>>nyquist(G,w); 
��c tính ��c bi&u di&n trên hình 1.1 
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�& xét tính  n �(nh c�a h$ kín dùng tiêu chu�n Nyquist, tr�c tiên ta xét tính  n �(nh c�a h$ h�. 
Nghi$m c�a ph�ng trình ��c tính c�a h$ h� ��c xác �(nh : 
>>pole(G) 
ans = 
 
        0           
  -0.5000 + 0.8660i 
  -0.5000 - 0.8660i 
  -0.1000           
H$ h� có 1 nghi$m b'ng 0 nên � biên gi�i  n �(nh. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Quan sát ��c tính t�n s� Nyquist c�a h$ h� trên hình 1.1 (ph�n zoom bên ph�i), ta th�y ��c tính 
Nyquist bao �i&m (-1,j0), và do h$ h� � biên gi�i  n �(nh nên theo tiêu chu�n Nyquist, h� th�ng 
kín s� không �n ��nh. 
 
Câu 2 
>>G_loop=feedback(G,1,-1) ;  % hàm truy�n h$ kín 
>>step(G_loop) ; 
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Hình 1.4 
�áp #ng quá �� h$ 
kín �ã hi$u ch)nh 

Câu 3 
>>K=0.111 ;num1=K ;  % thay � i h$ s� khu	ch ��i K 
>>GK=tf(num1,den1)*tf(num2,den2)  
Transfer function: 
           0.111 
---------------------------- 
10 s^4 + 11 s^3 + 11 s^2 + s 
>>margin(GK) 
��c tính t�n s� Bode c�a h$ h� �ã hi$u ch)nh ��c bi&u di%n trên hình 1.3. T� ��c tính này, ta có 
th& xác �(nh ��c 
 ∆L=18.34dB ; ∆ϕ = 44.78° ; ωc=0.085rad/s 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Câu 4 
>>GK_loop=feedback(GK,1,-1) ;   
>>step(GK_loop); 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Frequency (rad/sec)

P
ha

se
 (d

eg
);

 M
ag

ni
tu

de
 (

dB
)

Bode Diagrams

-150

-100

-50

0

50
Gm=18.344 dB (at 0.30151 rad/sec), Pm=44.775 deg. (at 0.084915 rad/sec)

10
-3

10
-2

10
-1

10
0

10
1

-400

-350

-300

-250

-200

-150

-100

-50

0

Hình 1.3 : ��c tính t�n s� Bode c�a h$ h� �ã hi$u ch)nh 
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Hình 2.1 C�a s  chính c�a Simulink 

 
 
S� d�ng con tr, chu�t và kích vào các �i&m c�n tìm trên ��c tính, ta xác �(nh ��c 
 σmax=23%; Tmax= 70.7s 

2 SIMULINK 
Simulink ��c tích h�p vào Matlab (vào kho�ng ��u nh�ng n/m 1990) nh m�t công c� �& 

mô ph,ng h$ th�ng, giúp ng�i s� d�ng phân tích và t ng h�p h$ th�ng m�t cách tr�c quan.  
Trong Simulink, h$ th�ng không ��c mô t� d�i d�ng dòng l$nh theo ki&u truy�n th�ng mà � 
d�i d�ng s� �� kh�i. V�i d�ng s� �� kh�i này, ta có th& quan sát các �áp #ng th�i gian c�a h$ 
th�ng v�i nhi�u tín hi$u vào khác nhau nh : tín hi$u b�c thang, tín hi$u sinus, xung ch� nh�t, tín 
hi$u ng*u nhiên… b'ng cách th�c hi$n mô ph,ng. K	t qu� mô ph,ng có th& ��c xem theo th�i 
gian th�c trên các Oscilloscope trong môi tr�ng Simulink, hay trong môi tr�ng Matlab. 

Simulink hoàn toàn t�ng thích v�i Matlab, nhng nó là m�t dao di$n �� h�a. Vì v�y t�t c� 
các hàm trong Matlab ��u có th& truy c�p ��c t� Simulink, ngay c� các hàm do ng�i s� d�ng 
t�o ra. Ng�c l�i, các k	t qu� tìm ��c trong Simulink ��u có th& ��c s� d�ng và khai thác 
trong môi tr�ng Matlab. 

Cu�i cùng, Simulink cho phép ng�i s� d�ng kh� n/ng t�o ra m�t th vi$n kh�i riêng. Ví 
d�, n	u b�n mu�n làm vi$c trong l"nh v�c �i�u khi&n các máy �i$n, b�n có th& t�o ra m�t th 
vi$n riêng ch#a các mô hình máy �i$n… Nh v�y, v�i công c� Simulink, ta có th& t� ti	n hành 
mô ph,ng thí nghi$m, quan sát k	t qu�, ki&m ch#ng v�i lý thuy	t tr�c khi ti	n hành thí nghi$m 
trên mô hình th�t. 

2.1 Kh�i ��ng Simulink 
�& kh�i ��ng Simulink t� môi tr�ng Matlab, ta 

gõ dòng l$nh simulink. Lúc này m�t c�a s� nh trên 
hình 2.1 s� xu�t hi$n, trên �ó có các th m�c chính và 
các th vi$n con c�a Simulink.  �& b
t ��u làm vi$c, ta 
t�o c�a s  m�i b'ng cách kích vào bi&u t�ng « New ». 
Có 8 th vi$n chính c�a Simulink ��c phân lo�i nh 
sau : 
- Continuous : h$ th�ng tuy	n tính và liên t�c 
- Discrete : h$ th�ng tuy	n tính gián �o�n 
- Nonliear : mô hình hóa nh�ng ph�n t� phi tuy	n 

nh r�le, ph�n t� bão hòa… 
- Source : các kh�i ngu�n tín hi$u 
- Sinks : các kh�i thu nh�n tín hi$u 
- Function & Table : các hàm b�c cao c�a Matlab 
- Math : các kh�i c�a simulink v�i các hàm toán h�c 

t�ng #ng c�a Matlab 
- Signals & System : các kh�i liên h$ tín hi$u, h$ 

th�ng con… 
 
 

2.2 T�o m�t s
 �� �
n gi�n 
�& làm quen v�i Simulink, ta b
t ��u b'ng m�t ví d� ��n gi�n : phân tích hàm quá �� c�a 

m�t khâu b�c hai có hàm truy�n 2
00

2

2
0

2
)(

ωξω
ω

++
=

pp
pG  v�i ω0=1rad/s và ξ=0,5. Các b�c 

th�c hi$n �& ��c s� �� mô ph,ng nh hình 2.2 nh sau : 
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- Kh�i ��ng Simulink t� Matlab b'ng dòng l$nh simulink 
- Trong c�a s  chính c�a Simulink, ch�n bi&u t�ng « New » �& t�o c�a s  #ng d�ng. 
- Mu�n t�o m�t kh�i trong c�a s  #ng d�ng, ta tìm kh�i �ó trong các th vi$n c�a Simulink, 

kích ch�n và kéo nó vào c�a s  #ng  d�ng. Ví d�, �& t�o kh�i Step, ta vào th vi$n Simulink -
> Continuous -> Sources -> Step, kh�i Transfer Fcn trong Simulink -> Continuous -> 
Transfer Fcn… 

- �& ��t thông s� cho t�ng kh�i, ta m� kh�i �ó ra b'ng cách double-click chu�t vào nó. Lúc 
này ��t các thông s� theo h�ng d*n trên màn hình. 

- ��ng n�i gi�a các kh�i ��c th�c hi$n b'ng cách dùng chu�t kéo các m0i tên � ��u (cu�i) 
m1i kh�i �	n v( trí c�n n�i. 

 
Sau khi t�o ��c s� �� kh�i nh hình 2.2, ta có th& b
t ��u ti	n hành mô ph,ng (v�i các tham s� 
m�c �(nh) b'ng cách ch�n Simulation -> Start. Xem k	t qu� mô ph,ng b'ng cách m� kh�i 
Scope nh hình 2.3. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
�& xem ��ng th�i tín hi$u vào và ra trên cùng m�t Scope, ta t�o s� �� mô ph,ng nh hình 2.4. 
K	t qu� mô ph,ng bi&u di%n trên hình 2.5. 
 
 
 
 
 
 
 
 
 
 
 
 
 

Hình 2.3 : K	t qu� mô ph,ng 

Hình 2. 4 

Hình 2. 5 

Hình 2.2 : M�t s� �� Simulink ��n gi�n 
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2.3 M�t s� kh�i th��ng dùng 

2.3.1 Th� vi�n « Sources » 
Step  T�o ra tín hi$u b�c thang liên t�c hay gián �o�n. 
Ramp  T�o tín hi$u d�c tuy	n tính (rampe) liên t�c. 
Sine Wave T�o tín hi$u sinus liên t�c hay gián �o�n. 
Constant T�o tín hi$u không � i theo th�i gian. 
Clock  Cung c�p ��ng h� ch) th�i gian mô ph,ng. Có th& xem ��c « ��ng h� » này khi 

�ang th�c hi$n mô ph,ng. 
Chú ý : Mu�n kh�i clock ch) �úng th�i �i&m �ang mô ph,ng, tham s� Sample time  ��c ��t 
nh sau 
 → 0 : h$ liên t�c 
 → >0 : h$ gián �o�n, clock lúc này s� ch) s� chu k+ l�y m*u ��t trong Sample time. 

2.3.2 Th� vi�n « Sinks » 
Scope   Hi&n th( các tín hi$u ��c t�o ra trong mô ph,ng.  
XY Graph V� quan h$ gi�a 2 tín hi$u theo d�ng XY. Kh�i này c�n ph�i có 2 tín hi$u 

vào, tín hi$u th# nh�t t�ng #ng v�i tr�c X, tín hi$u vào th# hai t�ng #ng 
v�i tr�c Y. 

To Workspace T�t c�c các tín hi$u n�i vào kh�i này s� ��c chuy&n sang không gian 
tham s� c�a Matlab khi th�c hi$n mô ph,ng. Tên c�a bi	n chuy&n vào 
Matlab do ng�i s� d�ng ch�n. 

2.3.3 Th� vi�n « Continuous » 
Transfer Fcn Mô t� hàm truy�n c�a m�t h$ th�ng liên t�c d�i d�ng �a thc t� s�/�a 

thc m�u s�. Các h$ s� c�a �a th#c t� s� và m*u s� do ng�i s� d�ng nh�p 
vào, theo b�c gi�m d�n c�a toán t� Laplace. Ví d� �& nh�p vào hàm truy�n 

có d�ng 
1

12
2 ++

+
ss

s
, ta nh�p vào nh sau :Numerator [2 1], Denominator [1 

1 1]. 
State Space Mô t� hàm truy�n c�a m�t h$ th�ng liên t�c d�i d�ng ph
�ng trình tr�ng 

thái. Các ma tr�n tr�ng thái A, B, C, D ��c nh�p vào theo qui �c ma 
tr�n c�a Matlab. 

Integrator  Khâu tích phân. 
sDerivative  Khâu ��o hàm 
Transport Delay Khâu t�o tr% 

2.3.4 Th� vi�n « Discrete » 
Discrete Transfer Fcn Mô t� hàm truy�n c�a m�t h$ th�ng gián �o�n d�i d�ng �a thc 

t� s�/�a thc m�u s�. Các h$ s� c�a �a th#c t� s� và m*u s� do 
ng�i s� d�ng nh�p vào, theo b�c gi�m d�n c�a toán t� z. 

Discrete State Space Mô t� hàm truy�n c�a m�t h$ th�ng gián �o�n d�i d�ng ph
�ng 
trình tr�ng thái. Ng�i s� d�ng ph�i nh�p vào các ma tr�n tr�ng 
thái A,B,C,D và chu k+ l�y m*u. 

Discrete-Time Integrator Khâu tích phân c�a h$ th�ng gián �o�n. 
First-Order Hold Khâu gi� m*u b�c 1. Ng�i s� d�ng ph�i nh�p vào chu k+ l�y m*u. 
Zero-Order Hold Khâu gi� m*u b�c 0. Ng�i s� d�ng ph�i nh�p vào chu k+ l�y m*u. 

2.3.5 Th� vi�n « Signal&Systems » 
Mux Chuy&n nhi�u tín hi$u vào (vô h�ng hay vect�) thành m�t tín hi$u 

ra duy nh�t d�ng vect�. Vect� ngõ ra có kích th�c b'ng t ng kích 
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th�c c�a các vect� vào. S� các tín hi$u vào ��c �(nh ngh"a khi 
m� kh�i Mux. Ví d�, n	u ��t tham s� number of inputs là 3, ngh"a 
là có 3 tín hi$u vào phân bi$t, vô h�ng. N	u ��t number of inputs 
là [1 2] thì có 2 tín hi$u vào phân bi$t : tín hi$u th# nh�t vô h�ng, 
tín hi$u th# hai là vect� 2 thành ph�n. 

Demux Chuy&n 1 tín hi$u vào thành nhi�u tín hi$u ra, ng�c v�i kh�i Mux. 
In1 Chèn m�t c ng vào. Kh�i này cho phép giao ti	p gi�a s� �� chính 

và s� �� con. 
Out1 Chèn m�t c ng ra. 

2.3.6 Th� vi�n « Math » 
Abs     Tín hi$u ra là giá tr( tuy$t ��i c�a tín hi$u vào. 
Gain Tín hi$u ra b'ng tín hi$u vào nhân h$ s� Gain (do ng�i s� d�ng 

�inh ngh"a). 
Sign Tính d�u c�a tín hi$u vào,  b'ng 1 n	u tín hi$u vào > 0 
     b'ng 0 n	u tín hi$u vào = 0 
     b'ng -1 n	u tín hi$u vào < 0 
Sum Tín hi$u ra là t ng c�a các tín hi$u vào. 

2.4 Ví d 
�& mô ph,ng h$ th�ng trong ví d� � m�c 1.4, ta t�o s� �� kh�i trong Simulink nh hình 2.6. 
Thay � i h$ s� khu	ch ��i K (K=1 và K=0.111), ta ��c các �áp #ng quá �� c�a h$ kín trên hình 
2.7 và 2.8. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Hình 2.6 : S� �� mô ph,ng trong Simulink 

Hình 2.7 : �áp #ng quá �� (K=1) Hình 2.8 : �áp #ng quá �� (K=0.111) 
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2.5 LTI Viewer 
Nh ta �ã bi	t, khi th�c hi$n mô ph,ng trên Simulink, ta ch) có th& quan sát ��c các ��c 

tính th�i gian c�a h$ th�ng. �& có th& phân tích toàn di$n m�t h$ th�ng, ta c�n các ��c tính t�n s� 
nh ��c tính Bode, ��c tính Nyquist, qu2 ��o nghi$m s� v.v…  

« LTI Viewer » là m�t giao di$n �� h�a cho phép quan sát �áp #ng c�a m�t h$ th�ng 
tuy	n tính, trong l"nh v�c t�n s� c0ng nh th�i gian, mà không c�n gõ l�i l$nh hay l�p trình theo 
t�ng dòng l$nh nh trong Control System Toolbox. Nó s� d�ng tr�c ti	p s� �� kh�i trong 
Simulink. 

2.5.1 Kh�i ��ng LTI Viewer 
�& kh�i ��ng LTI Viewer t� Simulink, ta ch�n menu Tool -> Linear Analysis. 
Lúc này, Matlab s� m� 2 c�a s  m�i: 
- C�a s  LTI Viewer (hình 2.9) có 2 ph�n chính: 

o Ph�n c�a s  �� h�a dùng �& bi&u di%n các ��ng ��c tính. 
o Thanh công c� phía d�i ch) d*n cách s� d�ng LTI Viewer 

- C�a s  ch#a các �i&m input và output (hình 2.10). Các �i&m này ��c dùng �& xác �(nh �i&m 
vào/ra trên s� �� Simulink c�n phân tích.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2.5.2 Thi�t l�p các �i
m vào/ra cho LTI Viewer 
Dùng chu�t kéo rê các �i&m “input point”, “output point” trên c�a s  hình 2.10 và ��t lên các v( 
trí t�ng #ng trên s� �� Similink. 
 
Chú ý: Vi�c ch�n các �i�m ��t “input”, “output” ph�i phù h�p yêu c�u phân tích. LTI Viewer 
tính hàm truy	n b�ng cách tuy�n tính hóa h� th�ng v�i 2 �i�m input/output �ã �
�c ��nh ngh�a. 
Khi v� các ��c tính t�n s� c�ng nh
 th�i gian, LTI s� d�ng các h� th�ng �ã �
�c tuy�n tính hóa 
này. 

2.5.3 Tuy�n tính hóa m�t mô hình 
�& tìm mô hình gi�a 2 �i&m input/output �ã �(nh ngh"a, ta th�c hi$n nh sau: 
Ch�n c�a s  LTI Viewer (hình 2.9) → Ch�n memu Simulink →→→→ Get linearized model 
Lúc này, trong ph�n �� h�a c�a c�a s  LTI Viewer s� xu�t hi$n ��t tính quá �� c�a mô hình 
tuy	n tính hóa tìm ��c. 
�& xem các ��c tính khác trên LTI Viewer, ta ch) vi$c kích chu�t ph�i vào ph�n �� h�a, ch�n 
menu Plot Type  → ch�n lo�i ��c tính c�n quan sát. 

Hình 2.9 Hình 2.10 
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Ghi chú: 
- C# m1i l�n th�c hi$n tuy	n tính hóa m�t mô hình (Simulink →→→→ Get linearized model) thì 

LTI Viewer s� n�p mô hình hi$n hành t�i c�a s  Simulink vào không gian c�a nó. N	u gi�a 2 
l�n th�c hi$n tuy	n tính hóa, mô hình không có s� thay � i (c�u trúc hay thông s�) thì 2 mô 
hình tìm ��c t�ng #ng s� gi�ng nhau. 

- Có th& b�t/t
t ��c tính c�a m�t hay nhi�u mô hình �ã tìm ��c trong LTI Viewer b'ng cách: 
kích chu�t ph�i vào c�a s  �� h�a → ch�n Systems → ch�n mô hình c�n b�t/t
t. Ti$n ích này  
r�t c�n thi	t khi ta mu�n so sánh tác ��ng do s� bi	n � i m�t thông s� nào �ó �	n h$ th�ng. 

2.5.4 L�u và s� d�ng các thông s� c�a mô hình tuy�n tính hóa 
- �& lu mô hình tuy	n tính hóa v�a tìm ��c, ch�n memu File →→→→ Export… ??? 
- �& s� d�ng các thông s� c�a mô hình : 

o D�ng hàm truy�n  [num,den]=tfdata(« bien file »,’v’) 
o D�ng ph�ng trình tr�ng thái [A,B,C,D]=ssdata(« bien file ») 

2.5.5 Ví d� s� d�ng LTI Viewer 
Gi� s� �ã có hàm mô hình mô ph,ng trên c�a s  Simulink nh hình 2.6. S� d�ng LTI Viewer �& 
quan sát các ��c tính sau: 
- ��c tính t�n s� Nyquist c�a h$ h� khi cha hi$u ch)nh (K=1) và �ã hi$u ch)nh (K=0.111). 
- ��c tính t�n s� Bode c�a h$ h� �ã hi$u ch)nh . 
- ��c tính quá �� c�a h$ kín cha hi$u ch)nh và �ã hi$u ch)nh. 
 
TH.C HI�N 
Theo yêu c�u ��t ra, ta c�n ph�i có 4 h$ th�ng có thông s� và c�u trúc khác nhau: h$ h� v�i K=1, 
h$ h� v�i K=0.111, h$ kín K=1 và h$ kín K=0.111. Do v�y, ta c�n th�c hi$n 4 l�n tuy	n tính hóa 
�& có ��c 4 mô hình khác nhau trong LTI Viewer. Các b�c th�c hi$n tu�n t� nh trong hình 
2.11. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

a) 

b) 

c) 

d) 

Hình 2.11 : S� �� và c�u trúc �& tuy	n tính hóa 
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Sau 4 l�n tuy	n tính hóa, trong LTI Viewer, ta ��c 4 h$ th�ng l�n l�t là baitap1_simulink_1 
�	n baitap1_simulink_4 (s� �� trong Simulink có tên là baitap1_simulink). 
 
Trên c�a s  �� h�a lúc này s� hi&n th( ��ng th�i ��c tính quá �� c�a c� 4 mô hình � trên. 
- �& xem ��c tính Nyquist c�a h$ h� tr�c và sau hi$u ch)nh: 

o Kích chu�t ph�i vào ph�n �� h�a, ch�n Systems, ch�n 2 mô hình 1 và 2. 
o Ti	p t�c kích chu�t ph�i vào ph�n �� h�a, ch�n Plot Type → Nyquist. 

Trên c�a s  �� h�a s� xu�t hi$n 2 ��c tính Nyquist v�i 2 màu phân bi$t. 
- �& xem ��c tính quá �� c�a h$ kín tr�c và sau hi$u ch)nh: 

o Kích chu�t ph�i vào ph�n �� h�a, ch�n Systems, ch�n 2 mô hình 3 và 4. 
o Ti	p t�c kích chu�t ph�i vào ph�n �� h�a, ch�n Plot Type → Step. 

 
Các ��c tính khác ��c ti	n hành m�t cách t�ng t�. 


